Chapter 308

Tests for Two Total Variances in a Replicated Design

Introduction

This procedure calculates power and sample size of tests of total variance (between + within) from a parallel (two-group) design with replicates (repeated measures) for the case when the ratio assumed by the null hypothesis is one. This is the common case. This routine expresses the effect size in terms of the ratio of the total variances.

A parallel design is used to compare two treatment groups by comparing subjects receiving each treatment. In this replicated design, each subject is measured $M$ times where $M$ is at least two. To be clear, each subject receives only on treatment, but is measured repeatedly.

Replicated parallel designs such as this are popular because they allow the assessment of total variances, between-subject variances, and within-subject variances.

It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout period between measurements.

Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 221 - 224.

Suppose $x_{ijk}$ is the response of the $i$th treatment ($i = T, C$), $j$th subject ($j = 1, \ldots, Ni$), and $k$th replicate ($k = 1, \ldots, M$). The model analyzed in this procedure is

$$x_{ijk} = \mu_i + S_{ij} + e_{ijk}$$

where $\mu_i$ is the treatment effect, $S_{ij}$ is the random effect of the $j$th subject in the $i$th treatment, and $e_{ijk}$ is the within-subject error term which is normally distributed with mean 0 and variance $V_i = \sigma_{Wi}^2$.

Unbiased estimates of these variances are given by

$$s_{Wi}^2 = \frac{1}{Ni(M - 1)} \sum_{j=1}^{Ni} \sum_{k=1}^{M} (x_{ijk} - \bar{x}_{ij})^2, \ i = T, C$$

where

$$\bar{x}_{ij} = \frac{1}{M} \sum_{k=1}^{M} x_{ijk}$$
Similarly, the between-subject variances are estimated as
\[
s_{B_i}^2 = \frac{1}{N_i - 1} \sum_{j=1}^{N_i} (\bar{x}_{ij} - \bar{x}_{i.})^2
\]
where
\[
\bar{x}_{i.} = \frac{1}{N_i} \sum_{j=1}^{N_i} \bar{x}_{ij}.
\]
Now, estimators for the total variance are given by
\[
\hat{\sigma}_{T_i}^2 = s_{B_i}^2 + \frac{(M - 1)}{M} s_{W_i}^2
\]

### Testing Variance Inequality

The following three sets of statistical hypotheses are used to test for total variance inequality with a non-unity null

- \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \geq 1 \) versus \( H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} < 1 \),
- \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \leq 1 \) versus \( H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} > 1 \),
- \( H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} = 1 \) versus \( H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \neq 1 \).

Let \( \eta = \sigma_{TT}^2 - (\sigma_{TC}^2) \) be the parameter of interest. The test statistic is \( \hat{\eta} = \hat{\sigma}_{TT}^2 - (\hat{\sigma}_{TC}^2) \).

### Two-Sided Test

For the two-sided test, compute two limits, \( \hat{\eta}_L \) and \( \hat{\eta}_U \), using
\[
\hat{\eta}_L = \hat{\eta} - \sqrt{\Delta_L}
\]
\[
\hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U}
\]
Reject the null hypothesis if \( \hat{\eta}_L > 0 \) is or \( \hat{\eta}_U < 0 \).

The \( \Delta \)s are given by
\[
\Delta_L = h \left( \frac{\alpha}{2}, N_T - 1 \right) s_{BT}^4 + h \left( 1 - \frac{\alpha}{2}, N_C - 1 \right) s_{BC}^4 + h \left( \frac{\alpha}{2}, N_T(M - 1) \right) \left[ \frac{(M - 1)s_{WT}^2}{M} \right]^2
\]
\[
\Delta_U = h \left( 1 - \frac{\alpha}{2}, N_T - 1 \right) s_{BT}^4 + h \left( \frac{\alpha}{2}, N_C - 1 \right) s_{BC}^4 + h \left( \frac{\alpha}{2}, N_T(M - 1) \right) \left[ \frac{(M - 1)s_{WT}^2}{M} \right]^2
\]
where

\[ h(A, B) = \left( 1 - \frac{B}{\chi^2_{A,B}} \right)^2 \]

and \( \chi^2_{A,B} \) is the upper quantile of the chi-square distribution with \( B \) degrees of freedom.

**One-Sided Test**

For the lower, one-sided test, compute the limit, \( \hat{\eta}_U \), using

\[ \hat{\eta}_U = \hat{\eta} + \sqrt{\Delta_U} \]

Reject the null hypothesis if \( \hat{\eta}_U < 0 \).

The \( \Delta_U \) is given by

\[
\begin{align*}
\Delta_U &= h(1 - \alpha, N_T - 1)s^4_{BT} + h(\alpha, N_C - 1)s^4_{BC} + h(\alpha, N_T(M - 1)) \left[ \frac{(M - 1)s^2_{WT}}{M} \right]^2 \\
&+ h(1 - \alpha, N_C(M - 1)) \left[ \frac{(M - 1)s^2_{WC}}{M} \right]^2
\end{align*}
\]

**Power**

**Two-Sided Test**

The power of the two-sided test assuming \( n = N_T = N_C \) is given by

\[
\text{Power} = 1 - \Phi \left( z_{1-\alpha} - \frac{(R_1 - 1)\sigma^2_{T_C}}{\sqrt{\sigma^*}} \sqrt{n} \right) + \Phi \left( z\frac{\alpha}{2} - \frac{(R_1 - 1)\sigma^2_{T_C}}{\sqrt{\sigma^*}} \sqrt{n} \right)
\]

where

\[
\begin{align*}
R_1 &= \frac{\sigma^2_{TT}}{\sigma^2_{T_C}} \\
\sigma^2_{T_T} &= R_1\sigma^2_{T_C} \\
\sigma^* &= 2 \left( \frac{\sigma^2_{BT}}{M} + \frac{\sigma^2_{WT}}{M} \right)^2 + \left( \frac{\sigma^2_{BC}}{M} + \frac{\sigma^2_{WC}}{M} \right)^2 + \frac{(M - 1)s^4_{WT}}{M^2} + \frac{(M - 1)s^4_{WC}}{M^2}
\end{align*}
\]

where \( RI \) is the value of the variance ratio stated by the alternative hypothesis and \( \Phi(x) \) is the standard normal CDF.

A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary sample size.

**One-Sided Test**

The power of the lower, one-sided test, \( H_0: \frac{\sigma^2_T}{\sigma^2_{T_C}} \geq 1 \) versus \( H_1: \frac{\sigma^2_T}{\sigma^2_{T_C}} < 1 \), is given by

\[
\text{Power} = \Phi \left( z\alpha - \frac{(R_1 - 1)\sigma^2_{T_C}}{\sqrt{\sigma^*}} \sqrt{n} \right)
\]
The power of the upper, one-sided test, $H_0: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} \leq 1$ versus $H_1: \frac{\sigma_{TT}^2}{\sigma_{TC}^2} > 1$, is given by

$$\text{Power} = 1 - \Phi \left( z_{1-\alpha} - \frac{(R_1 - 1)\sigma_{TC}^2}{\sqrt{\sigma^2/n}} \right)$$

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

**Solve For**

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

**Test Direction**

**Alternative Hypothesis**

Specify whether the alternative hypothesis of the test is one-sided or two-sided.

Note that this parameter impacts the value of alpha. The value of alpha is used directly for one-sided tests. For two-sided tests, alpha is replaced by alpha/2.

**Two-Sided Hypothesis Test**

$H_0: \sigma_{TT}/\sigma_{TC}^2 = 1$ vs. $H_1: \sigma_{TT}/\sigma_{TC}^2 \neq 1$

**One-Sided Hypothesis Tests**

- **Lower**: $H_0: \sigma_{TT}/\sigma_{TC}^2 \geq 1$ vs. $H_1: \sigma_{TT}/\sigma_{TC}^2 < 1$
- **Upper**: $H_0: \sigma_{TT}/\sigma_{TC}^2 \leq 1$ vs. $H_1: \sigma_{TT}/\sigma_{TC}^2 > 1$

**Power and Alpha**

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of nonequivalent means when in fact the means are equivalent.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when it is true.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size

Sample Size Per Group
The Sample Size Per Group is the number of items or individuals sampled in a group. Since the sample sizes are the same in each group, this value is the value for \( N_T \) and \( N_C \).

The Sample Size Per Group must be \( \geq 2 \). You can enter a single value or a series of values.

M (Measurements Per Subject)
Enter one or more values for \( M \): the number of repeated measurements per subject. All measurements are for the same treatment.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is \( M \geq 2 \).

Effect Size

R1 (Actual Variance Ratio)
Enter one or more values for total variance ratio assumed by the alternative hypothesis. This is the value of \( \sigma^2_{TT} / \sigma^2_{TC} \) at which the power is calculated.

The range of possible values is \( R1 > 0, \ R1 \neq 1 \).

\( \sigma^2_{TC} \) (Control Variance)
Enter one or more values for variance of the average subject control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is \( \sigma^2_{TC} > \sigma^2_{WT} \).

\( \sigma^2_{WT} \) (Treatment, Within-Subject Variance)
Enter one or more values for within-subject variance of the treatment measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is \( \sigma^2_{WT} > 0 \).

\( \sigma^2_{WC} \) (Control, Within-Subject Variance)
Enter one or more values for within-subject variance of the control measurements. This value will have to be determined from a previous study or a pilot study.

The range of possible values is \( \sigma^2_{WC} < \sigma^2_{TC} \).
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to compare it to the standard drug in terms of the total variability. A two-group, parallel design will be used to test the inequality using a two-sided test.

Company researchers set the significance level to 0.05, the power to 0.90, M to 2, and the actual variance ratio values between 0.5 and 1.3. They also set $\sigma^2_{tc} = 0.8$, $\sigma^2_{wt} = 0.2$, and $\sigma^2_{wc} = 0.3$. They want to investigate the range of required sample size values assuming that the two group sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for Two Total Variances in a Replicated Design procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value

<table>
<thead>
<tr>
<th>Design Tab</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided (H1: $\sigma^2_{tt}/\sigma^2_{tc} \neq 1$)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>M</td>
<td>2</td>
</tr>
<tr>
<td>R1</td>
<td>0.5 0.7 0.9 1.1 1.3</td>
</tr>
<tr>
<td>$\sigma^2_{tc}$</td>
<td>0.8</td>
</tr>
<tr>
<td>$\sigma^2_{wt}$</td>
<td>0.2</td>
</tr>
<tr>
<td>$\sigma^2_{wc}$</td>
<td>0.3</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Grp T Sample Size</th>
<th>Grp C Sample Size</th>
<th>Num Reps</th>
<th>Actual Var Ratio</th>
<th>Total Var Cntl</th>
<th>Wthn Subj Var</th>
<th>Wthn Subj Cntl</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9009</td>
<td>244</td>
<td>244</td>
<td>144</td>
<td>2</td>
<td>0.50</td>
<td>0.80</td>
<td>0.20</td>
<td>0.30</td>
</tr>
<tr>
<td>0.9001</td>
<td>2757</td>
<td>2757</td>
<td>5514</td>
<td>2</td>
<td>0.70</td>
<td>0.80</td>
<td>0.20</td>
<td>0.30</td>
</tr>
<tr>
<td>0.9000</td>
<td>3492</td>
<td>3492</td>
<td>6984</td>
<td>2</td>
<td>0.90</td>
<td>0.80</td>
<td>0.20</td>
<td>0.30</td>
</tr>
<tr>
<td>0.9004</td>
<td>489</td>
<td>489</td>
<td>978</td>
<td>2</td>
<td>1.10</td>
<td>0.80</td>
<td>0.20</td>
<td>0.30</td>
</tr>
</tbody>
</table>

References


Report Definitions
Actual Power is the actual power achieved. Because \( N_t \) and \( N_c \) are discrete, this value is usually slightly larger than the target power.

\( N_t \) is the number of subjects in the treatment group.
\( N_c \) is the number of subjects in the control group.
\( N \) is the total number of subjects. \( N = N_t + N_c \).
\( M \) is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a subject.
\( R_1 \) is the value of the total variance ratio at which the power is calculated.
\( \sigma^2_{tc} \) is the total variance of measurements in the control group. Note that \( \sigma^2_{tc} = \sigma^2_{wc} + \sigma^2_{wt} \).
\( \sigma^2_{wt} \) is the within-subject variance of measurements in the treatment group.
\( \sigma^2_{wc} \) is the within-subject variance of measurements in the control group.
\( \alpha \) is the probability of rejecting a true null hypothesis, \( H_0 \).

Summary Statements
A study is being conducted to compare the total variance of a treatment group to a control group using a two-sided hypothesis test of data from a replicated parallel design. Group sample sizes of 72 and 72 achieve 90% power to reject the null hypothesis at a significance level of 0.050. The variance ratio assumed by the null hypothesis is 1.0. The variance ratio at which the power is calculated is 0.500. The number of times the measurement is repeated on a subject is 2. The actual total variance of the control group is assumed to be 0.800. The actual within-subject variance of the treatment group is assumed to be 0.200. The actual within-subject variance of the control group is assumed to be 0.300.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and \( R_1 \).
Example 2 – Validation using PASS

We will use an example from a previously validated PASS procedure to validate this procedure. The previously validated procedure is Non-Unity Null Tests for Two Total Variances in a Replicated Design.

For this example, if in the other procedure we set power = 0.8, R0 = 1, significance level = 0.05, M = 3, R1 = 0.52, σ^2 tc = 0.25, σ^2 wt = 0.04, σ^2 wc = 0.09, the resulting per group sample size is 43.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for Two Total Variances in a Replicated Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td></td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>One-Sided (H1: σ^2 tt/σ^2 tc &lt; 1)</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>3</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.52</td>
</tr>
<tr>
<td>σ^2 tc (Control Variance)</td>
<td>0.25</td>
</tr>
<tr>
<td>σ^2 wt (Treatment Variance)</td>
<td>0.04</td>
</tr>
<tr>
<td>σ^2 wc (Control Variance)</td>
<td>0.09</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Num</th>
<th>Grp T</th>
<th>Grp C</th>
<th>Num</th>
<th>Actual</th>
<th>Total</th>
<th>Wthn</th>
<th>Wthn</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power</td>
<td>Size</td>
<td>Reps</td>
<td>Var</td>
<td>Var</td>
<td>Subj</td>
<td>Subj</td>
</tr>
<tr>
<td></td>
<td>0.8080</td>
<td>43</td>
<td>86</td>
<td>M 3</td>
<td>R1 0.520</td>
<td>σ^2 tc 0.250</td>
<td>σ^2 wt 0.040</td>
</tr>
</tbody>
</table>

The sample size of 43 per group matches the expected result.